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Use this help file to learn about NI Example Finder, a utility that allows
you to browse and search installed examples and examples on the NI
Developer Zone.
For more information about this help file, refer to the following topics:
Using Help
Important Information
Technical Support and Professional Services
To comment on National Instruments documentation, refer to the National
Instruments Web site.
© 2003–2007 National Instruments Corporation. All rights reserved.

Using Help
Conventions
Navigating Help
Searching Help
Printing Help File Topics

Conventions
This help file uses the following formatting and typographical
conventions:
»

The » symbol leads you through nested menu items and
dialog box options to a final action. The sequence File»Page
Setup»Options directs you to pull down the File menu,
select the Page Setup item, and select Options from the last
dialog box.
This icon denotes a tip, which alerts you to advisory
information.
This icon denotes a note, which alerts you to important
information.

blue

Text in this color denotes a specific platform and indicates
that the text following it applies only to that platform.

bold

Bold text denotes items that you must select or click in the
software, such as menu items and dialog box options.

green

Underlined text in this color denotes a link to a help topic,
help file, or Web address.

italic

Italic text denotes variables, emphasis, or cross-references.
Italic text also denotes text that is a placeholder for a word or
value that you must supply.

monospace Text in this font denotes text or characters that you should
enter from the keyboard, sections of code, programming
examples, and syntax examples. This font is also used for
the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names,
functions, operations, variables, filenames, and extensions.

Navigating Help (Windows Only)
To navigate this help file, use the Contents, Index, and Search tabs to
the left of this window or use the following toolbar buttons located above
the tabs:
Hide—Hides the navigation pane from view.
Locate—Locates the currently displayed topic in the Contents tab,
allowing you to view related topics.
Back—Displays the previously viewed topic.
Forward—Displays the topic you viewed before clicking the Back
button.
Options—Displays a list of commands and viewing options for the
help file.

Searching Help (Windows Only)
Use the Search tab to the left of this window to locate content in this help
file. If you want to search for words in a certain order, such as "related
documentation," add quotation marks around the search words as shown
in the example. Searching for terms on the Search tab allows you to
quickly locate specific information and information in topics that are not
included on the Contents tab.

Wildcards
You also can search using asterisk (*) or question mark (?) wildcards.
Use the asterisk wildcard to return topics that contain a certain string. For
example, a search for "prog*" lists topics that contain the words
"program," "programmatically," "progress," and so on.
Use the question mark wildcard as a substitute for a single character in a
search term. For example, "?ext" lists topics that contain the words
"next," "text," and so on.
Note Wildcard searching will not work on Simplified Chinese,
Traditional Chinese, Japanese, and Korean systems.

Nested Expressions
Use nested expressions to combine searches to further refine a search.
You can use Boolean expressions and wildcards in a nested expression.
For example, "example AND (program OR VI)" lists topics that contain
"example program" or "example VI." You cannot nest expressions more
than five levels.

Boolean Expressions
Click the button to add Boolean expressions to a search. The following
Boolean operators are available:
AND (default)—Returns topics that contain both search terms. You
do not need to specify this operator unless you are using nested
expressions.
OR—Returns topics that contain either the first or second term.
NOT—Returns topics that contain the first term without the second
term.
NEAR—Returns topics that contain both terms within eight words
of each other.

Search Options
Use the following checkboxes on the Search tab to customize a search:
Search previous results—Narrows the results from a search that
returned too many topics. You must remove the checkmark from
this checkbox to search all topics.
Match similar words—Broadens a search to return topics that
contain words similar to the search terms. For example, a search
for "program" lists topics that include the words "programs,"
"programming," and so on.
Search titles only—Searches only in the titles of topics.

Printing Help File Topics (Windows Only)
Complete the following steps to print an entire book from the Contents
tab:
1. Right-click the book.
2. Select Print from the shortcut menu to display the Print Topics
dialog box.
3. Select the Print the selected heading and all subtopics option.
Note Select Print the selected topic if you want to print the
single topic you have selected in the Contents tab.
4. Click the OK button.

Printing PDF Documents
This help file may contain links to PDF documents. To print PDF
documents, click the print button located on the Adobe Acrobat Viewer
toolbar.

Adding Examples to the Favorites Folder
Use the Favorites folder on the Browse tab to organize and access the
examples you use most frequently. Adding an example to the Favorites
folder does not change the location of the example on your computer.
Complete the following steps to add an example to the Favorites folder
on the Browse tab.
1. Browse to or search for the example.
2. Select the example.
3. Click the Add to Favorites button.
Tip In the Browse according to section, select Task to display
the Favorites folder in the Double-click an example to open it
list.
To remove an example from the Favorites folder, select the example and
click the Remove from Favorites button.

Browsing for an Example
Use the Browse tab of the NI Example Finder to browse for examples
installed on your computer or on the NI Developer Zone Web site. You
also can browse for examples installed on your computer by the
hardware devices the examples use.
Complete the following steps to browse for an example.
1. In the Browse according to section, select Task to browse
examples that apply to a specific task you want to complete with
hardware or software. You also can select Directory Structure to
browse for examples by their installed location.
2. (Optional) (Windows and Linux) Place a checkmark in the
Include ni.com examples checkbox to include examples from NI
Developer Zone. You can browse the NI Developer Zone
examples only by task.
3. In the Double-click an example to open it list, double-click a
folder name to open that folder. Continue double-clicking items in
the list to find a specific example.
An icon appears next to each example to indicate the software and
hardware with which the example is compatible. The Requirements list
displays additional hardware and software that are required to run the
example. More information about each example appears in the
Information text box.
If you are browsing examples by task, the Toolkits and Modules Not
Installed folder in the Double-click an example to open it list includes
examples for toolkits and modules that are not currently installed. If you
select an example in the Toolkits and Modules Not Installed folder, the
Requirements list includes a link to more information about the required
toolkit or module.
If you place a checkmark in the Include ni.com examples checkbox, an
icon appears next to the example to indicate if the example is from NI
Developer Zone. If the example is from NI Developer Zone, you can
display comments, ratings, and related links for the example. You also
can specify how long the NI Example Finder queries NI Developer Zone
for examples. The ni.com query timeout indicator turns on after the
query times out.

Displaying Example Comments, Ratings, and
Related Links (Windows)
Use the Resources list to view or submit comments and ratings and view
related links for NI Developer Zone examples. Use the Configure
Example Finder dialog box to configure Web settings and to configure
the appearance of the Resources list.
Note You can display comments, ratings, and related links only for
examples on NI Developer Zone.
Use the following options in the Resources list:
Ratings—Displays the example rating and the number of ratings
submitted.
Rate this example—Displays the Submit Example Rating dialog
box, which you can use to rate the example and enter comments
about the example. The Ratings section of the Resources
displays the average rating of each example, which helps guide
other users to the most useful examples posted on the Web.
View user comments—Displays comments from other users
about the example. After you use an example, you can submit your
own comments in the Rate this example section or on the page
for the example on NI Developer Zone. National Instruments
reviews comments for content and refers comments dealing with
technical problems to National Instruments technical support. After
National Instruments reviews and posts submitted comments,
usually within a week of submission, other users can view them on
NI Developer Zone and in this section of the Resources list.
Browse related links—Lists related documents that are available
at NI Developer Zone and other Web sites.

Displaying Examples that Require a Specific
Hardware Device
Use the Hardware pull-down menu to display an icon if an example uses
a specific hardware device. You also can choose to display only
examples that require a specific hardware device. Complete the following
steps to display examples based on hardware requirements.
1. In the Hardware pull-down menu, select All devices in this
menu to display an arrow icon next to the examples that require
any hardware devices in the menu. You also can select a single
device from the Hardware pull-down menu to display an arrow
icon next to the examples that require that device.
The Requirements list displays additional hardware and software
that are required to run the example.
2. (Optional) Place a checkmark in the Limit results to hardware
checkbox to display only examples that use the hardware you
select in the Hardware pull-down menu.
3. Select Refresh hardware list from the Hardware pull-down
menu to update the Hardware pull-down menu with NI-DAQ
devices configured in Measurement & Automation Explorer
(MAX).
Note If selecting Refresh hardware list from the Hardware pulldown menu does not add an installed device to the Hardware pulldown menu, select Add device from the Hardware pull-down
menu to add a device manually.
Select Refresh hardware list from the Hardware pull-down menu the
first time you launch NI Example Finder and any time you add or remove
a device to the Hardware pull-down menu.

NI Example Finder Icons
The following icons appear in the Double-click an example to open it
list on the Browse and Search tabs. Each icon indicates the source of
the example and the hardware or software with which the example is
compatible.
Icon

Description
Denotes LabVIEW example VIs.
Denotes LabVIEW project-based examples.
Denotes LabVIEW project-based examples compatible with the
LabVIEW Real-Time Module.
Denotes LabVIEW project-based examples that do not run unless
you have the LabVIEW Real-Time Module installed.
Denotes examples compatible with CompactRIO.
Denotes examples compatible with the LabVIEW Real-Time
Module.
Denotes examples that do not run unless you have the LabVIEW
Real-Time Module installed.
Denotes examples compatible with LabWindows™/CVI™
software.
Denotes examples that are compatible with DIAdem software.
Denotes examples that are compatible with the device selected in
the Hardware menu, and examples that are compatible with every
device in the Hardware menu if All devices in this menu is
selected.
Denotes examples compatible with National Instruments data
acquisition devices using NI-DAQmx.
Denotes examples compatible with National Instruments data
acquisition devices using Traditional NI-DAQ.
Denotes examples compatible with National Instruments FPGA
devices.
Denotes examples compatible with National Instruments FieldPoint
devices.
Denotes examples that require a National Instruments high-

frequency signal generator device.
Denotes examples that require a National Instruments highfrequency signal analyzer device.
Denotes examples compatible with National Instruments highspeed digital I/O devices.
Denotes examples compatible with National Instruments image
acquisition devices.
Denotes examples compatible with National Instruments motion
control devices.
Denotes examples compatible with National Instruments IF
transceiver devices.
Denotes examples that include .m files compatible with LabVIEW
MathScript.
Denotes examples compatible with NI-CAN.
Denotes examples compatible with NI-DMM.
Denotes examples compatible with NI-FGen.
Denotes examples compatible with NI-SCOPE.
Denotes examples compatible with NI-SWITCH.
Denotes examples compatible with the LabVIEW PDA Module.
Denotes examples compatible with serial devices.
Denotes examples that require multiple devices.
Denotes examples at the NI Developer Zone.
Denotes third-party examples from the NI Developer Zone.

Configuring the NI Example Finder
Complete the following steps to configure hardware, software, and Web
settings for the NI Example Finder.
1. Click the Setup button to display the Configure Example Finder
dialog box.
2. Click the Hardware tab to configure hardware settings for the NI
Example Finder.
a. To find examples for specific devices, select a device
name in the Select devices to find examples for list and
click the right arrow button.
b. Place a checkmark in the Show Hardware menu
checkbox to display the Hardware pull-down menu on the
Browse and Search tabs. You can use this pull-down
menu to select specific devices for which to find examples.
3. (Windows and Linux) Click the Web tab to configure Web
settings for the NI Example Finder.
a. In the Maximum number of Web query results field, use
the increment and decrement buttons to select a value or
enter a value for the maximum number of examples that
you want the NI Example Finder to find on the Web.
b. In the Web query time limit (seconds) field, use the
increment and decrement buttons to select a value or enter
a value for the maximum amount of time the NI Example
Finder queries the NI Developer Zone for examples.
c. Place a checkmark in the Show Resources list checkbox
to view or submit comments and ratings and view related
links for NI Developer Zone examples.
4. Click the General tab to configure the Most Recent folder and
display the Requirements list. The Most Recent folder appears
on the Browse tab of the NI Example Finder by default.
a. In the Maximum number of Most Recent folder entries
field, use the increment and decrement buttons to select a
value or enter a value for the maximum number of
examples to display in the Most Recent folder.
b. Place a checkmark in the Show Requirements list
checkbox to display a list of additional hardware and

software that are required to run the example.
5. Click the OK button to close the Configure Example Finder
dialog box and return to the NI Example Finder.

Searching for an Example
Use the Search tab of the NI Example Finder to search for examples
installed on your computer or examples on the NI Developer Zone. You
can search for installed examples by keyword or description. You can
search examples on NI Developer Zone only by keyword.
Note (Mac OS) You cannot search for examples on NI Developer
Zone.
Complete the following steps to search for an example by keyword.
1. Select the Keywords option from the pull-down menu next to the
Search button.
2. Enter the text you want to search for in the Enter keyword(s) text
box. You can enter more than one keyword to search for multiple
keywords. Select all the words or any of the words from the
Search for pull-down menu to configure a search for multiple
keywords.
3. (Optional) (Windows and Linux) To include examples from NI
Developer Zone in the search, place a checkmark in the Include
ni.com examples checkbox.
4. (Optional) To search for examples that work with a specific device,
select a device from the Hardware pull-down menu, or select Add
device from the Hardware pull-down menu to add a device that is
not installed or configured on your computer.
5. Click the Search button or double-click a keyword that appears in
the Double-click keyword(s) list.
Complete the following steps to search for an example by description.
Note You must remove the checkmark in the Include ni.com
examples checkbox to search for examples by description.
1. Select the Descriptions option from the pull-down menu next to
the Search button.
2. Enter the text you want to search for in the Enter keyword(s) text
box.
3. (Optional) To search for examples that work with a specific device,
select a device from the Hardware pull-down menu, or select Add
device from the Hardware pull-down menu to add a device that is

not installed or configured on your computer.
4. Click the Search button.
The results of the search appear in the Double-click an example to
open it list.
An icon appears next to each example to indicate the software and
hardware with which the example is compatible. The Requirements list
displays additional hardware and software that are required to run the
example. More information about each example appears in the
Information text box. If you searched the examples by description, the
text you search for is highlighted in the Information text box.
If you place a checkmark in the Include ni.com examples checkbox, an
icon appears next to the example to indicate if the example is from NI
Developer Zone. If the example is from NI Developer Zone, you can
display comments, ratings, and related links for the example. You also
can specify how long the NI Example Finder queries NI Developer Zone
for examples. The ni.com query timeout indicator turns on after the
query times out.

Submitting an Example to NI Developer Zone
On the Submit tab of NI Example Finder, click the Submit an Example
button to visit the NI Developer Zone, where you can share examples
with other developers.

Important Information
Warranty
Copyright
Trademarks
Patents
Warning Regarding Use of NI Products

Warranty
The media on which you receive National Instruments software are
warranted not to fail to execute programming instructions, due to defects
in materials and workmanship, for a period of 90 days from date of
shipment, as evidenced by receipts or other documentation. National
Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice
of such defects during the warranty period. National Instruments does not
warrant that the operation of the software shall be uninterrupted or error
free.
A Return Material Authorization (RMA) number must be obtained from
the factory and clearly marked on the outside of the package before any
equipment will be accepted for warranty work. National Instruments will
pay the shipping costs of returning to the owner parts which are covered
by warranty.
National Instruments believes that the information in this document is
accurate. The document has been carefully reviewed for technical
accuracy. In the event that technical or typographical errors exist,
National Instruments reserves the right to make changes to subsequent
editions of this document without prior notice to holders of this edition.
The reader should consult National Instruments if errors are suspected.
In no event shall National Instruments be liable for any damages arising
out of or related to this document or the information contained in it.
EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES
NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY
DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. CUSTOMER'S RIGHT TO RECOVER
DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT
THERETOFORE PAID BY THE CUSTOMER. NATIONAL
INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF
THE POSSIBILITY THEREOF. This limitation of the liability of National
Instruments will apply regardless of the form of action, whether in
contract or tort, including negligence. Any action against National
Instruments must be brought within one year after the cause of action

accrues. National Instruments shall not be liable for any delay in
performance due to causes beyond its reasonable control. The warranty
provided herein does not cover damages, defects, malfunctions, or
service failures caused by owner's failure to follow the National
Instruments installation, operation, or maintenance instructions; owner's
modification of the product; owner's abuse, misuse, or negligent acts;
and power failure or surges, fire, flood, accident, actions of third parties,
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or
transmitted in any form, electronic or mechanical, including photocopying,
recording, storing in an information retrieval system, or translating, in
whole or in part, without the prior written consent of National Instruments
Corporation.
National Instruments respects the intellectual property of others, and we
ask our users to do the same. NI software is protected by copyright and
other intellectual property laws. Where NI software may be used to
reproduce software or other materials belonging to others, you may use
NI software only to reproduce materials that you may reproduce in
accordance with the terms of any applicable license or other legal
restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of
National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks.
FireWire® is the registered trademark of Apple Computer, Inc.
Handle Graphics®, MATLAB®, Real-Time Workshop®, Simulink®,
Stateflow®, and xPC TargetBox® are registered trademarks, and
TargetBox™ and Target Language Compiler™ are trademarks of The
MathWorks, Inc.
Tektronix® and Tek are registered trademarks of Tektronix, Inc.
Other product and company names mentioned herein are trademarks or
trade names of their respective companies.
Members of the National Instruments Alliance Partner Program are
business entities independent from National Instruments and have no
agency, partnership, or joint-venture relationship with National
Instruments.

Patents
For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents.txt file on
your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL
INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED
WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY
SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL
IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT
SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.
(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF
OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY
ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO
FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER
HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM
SOFTWARE FITNESS, FITNESS OF COMPILERS AND
DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION,
INSTALLATION ERRORS, SOFTWARE AND HARDWARE
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF
ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT
FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR
SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON
THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE
FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY
TERMED "SYSTEM FAILURES"). ANY APPLICATION WHERE A
SYSTEM FAILURE WOULD CREATE A RISK OF HARM TO
PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY
INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE
FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR
APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT
STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT
NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS.
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND
DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS
AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE
NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH
OTHER PRODUCTS IN A MANNER NOT EVALUATED OR
CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR

APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR
VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS
PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION,
INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN,
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR
APPLICATION.

Technical Support and Professional Services
Visit the following sections of the National Instruments Web site at ni.com
for technical support and professional services:
Support—Online technical support resources at ni.com/support
include the following:
Self-Help Resources—For answers and solutions, visit the
award-winning National Instruments Web site for software
drivers and updates, a searchable KnowledgeBase, product
manuals, step-by-step troubleshooting wizards, thousands of
example programs, tutorials, application notes, instrument
drivers, and so on.
Free Technical Support—All registered users receive free
Basic Service, which includes access to hundreds of
Applications Engineers worldwide in the NI Discussion
Forums at ni.com/forums. National Instruments Applications
Engineers make sure every question receives an answer.
For information about other technical support options in your
area, visit ni.com/services or contact your local office at
ni.com/contact.
Training and Certification—Visit ni.com/training for self-paced
training, eLearning virtual classrooms, interactive CDs, and
Certification program information. You also can register for
instructor-led, hands-on courses at locations around the world.
System Integration—If you have time constraints, limited in-house
technical resources, or other project challenges, National
Instruments Alliance Partner members can help. To learn more,
call your local NI office or visit ni.com/alliance.
If you searched ni.com and could not find the answers you need, contact
your local office or NI corporate headquarters. You also can visit the
Worldwide Offices section of ni.com/niglobal to access the branch office
Web sites, which provide up-to-date contact information, support phone
numbers, email addresses, and current events.

JavaScript Disabled
The HTML file you are trying to access uses JavaScript.
(Windows) If you are viewing the file from your computer or from a CD
and you have Internet Explorer 4.0 or later installed, JavaScript is
enabled by default. If you are viewing the file from a network, such as on
an intranet or on the Web, or if you do not have Internet Explorer 4.0 or
later installed, you must enable JavaScript to view the file.
(Mac OS and Linux) Your browser does not support JavaScript, or you
have disabled JavaScript. If your browser does not support JavaScript,
install a recent browser version that does support JavaScript.
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